
 

What's New in Suite 2000 
What's New in Suite 2000 contains important information that may not be available in any other Waypoint Global 
documentation source. It also contains information that should be read before upgrading to a newer version of the software. 

How to Navigate in this File 

This What's New file contains the information for each version of Suite 2000, starting with the most recent version back to 
V3.00. What's new documentation for prior versions are available in the "POWERWAY Product Guides" binder in Desktop. 
You can scroll through the entire file from top to bottom or view information for a specific version. 

 
System Requirements 
The following are the hardware and software requirements for Suite 2000 V3.60: 

Personal Edition 

Component Requirements 
Hardware Processor - 500 MHz or higher 

Memory - 1GB 
Disk - 500MB 
Video - 800x600 resolution, 256 Colors

Operating 
System 

Windows 2000 (Upgrade only, New installs are no longer supported) 
Windows XP (32-bit) 
Windows XP (64-bit) (New for V3.20) 
Vista (32-bit) (New for V3.00) 
Vista (64-bit) (New for V3.20) 
Windows 7 (32-bit) (New for V3.01) 
Windows 7 (64-bit) (New for V3.20)

Notes: 1. Suite 2000 software will not run on earlier versions of Windows or 
Windows emulation systems that run on OS/2, UNIX or Macintosh 
computers. Peer-to-peer networking is not supported.  

2. 64-bit operating systems ARE supported as of V3.30. 
All Suite 2000 software applications are 32-bit; installing them on 64-bit 
versions of Windows is now supported. 
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Group Edition 

 

System Component Requirements 
Workstation Hardware Processor - 500 MHz or higher 

Memory - 1GB 
Disk - 500MB 
Video - 800x600 resolution, 256 Colors

Operating 
System 

Windows 2000 (Upgrade only, New installs are no longer supported) 
Windows XP (32-bit) 
Windows XP (64-bit) (New for V3.20) 
Vista (32-bit) (New for V3.00) 
Vista (64-bit) (New for V3.20) 
Windows 7 (32-bit) (New for V3.01) 
Windows 7 (64-bit) (New for V3.20)

Notes: 1. Suite 2000 software will not run on earlier versions of Windows or 
Windows emulation systems that run on OS/2, UNIX or Macintosh 
computers. Peer-to-peer networking is not supported.  

2. 64-bit operating systems ARE supported as of V3.30. 
All Suite 2000 software applications are 32-bit; installing them on 64-
bit versions of Windows is now supported. 

Database 
Server 

Hardware Processor - Fast multi-core or multi-processor 
Memory - 4GB

Operating 
System 

Windows Server 2000 (Upgrade only, New installs are no longer supported) 
Windows Server 2003 
Windows Server 2008 
Windows Server 2008 R2 (New for V3.30) 
  (Recommend Latest Service Pack)

Software Sybase ASA 7.03 
 
SQL Server 2005  
SQL Server 2008 (New for V3.01) 
SQL Server 2008 R2 (New for V3.60) 
  (Recommend Latest Service Pack) 

Note: SQL Server Express edition is not supported. Contact Waypoint 
Global for further information.

Repository 
Server 

Operating 
System 

Windows Server 2000 (Upgrade only, New installs are no longer supported) 
Windows Server 2003 
Windows Server 2008 
Windows Server 2008 R2 (New for V3.30) 
  (Recommend Latest Service Pack)

Note: A repository server is only used to store files in a network share. 
No service software runs on the repository server. 
Bitness (32/64) is not a necessary consideration.

Terminal 
Services 

Operating 
System 

Windows Server 2000 (Upgrade only, New installs are no longer supported) 
Windows Server 2003 
Windows Server 2008 
Windows Server 2008 R2 (New for V3.30) 
  (Recommend Latest Service Pack)

Note: 64-bit operating systems ARE supported as of V3.30. 
All Suite 2000 software applications are 32-bit; installing them on 64-bit 
versions of Windows is now supported.
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Minimum Upgrade Requirements 

Upgrades will work on the following version numbers of Suite 2000 or higher. 

CD Version 1.03 
Audit Manager 2.04 
Corrective Action 2.04 
Desktop 5.04 
Document Manager 4.04 
Instruction Writer 6.04 
Policy Writer 6.04 
Procedure Writer 6.04 
Quality Planner 2.04 
SPC-Administration 4.03 
SPC-Examiner 4.03 
SPC-Operator 4.03 
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Suite 2000 V3.60 
Windows Authentication and Single Sign-On 

With this version of the Suite we are happy to introduce Windows Authentication and Single Sign-On support for 
Microsoft Windows Networks. 
 

Windows Authentication - Users can now be configured to have their Suite logon authentication performed 
using their Windows logon name and password. A new "Use Windows Authentication" checkbox is now 
available when editing users in Desktop. 

 
This checkbox changes the user's configuration to no longer store a password in the database. Instead you 
identify the Windows domain and user that corresponds to the Suite user. 

 
From now on the President user can logon as CWTech\CWHarris or President and use their password stored in 
the Windows Network. 

 
Notes: 

User password rules are now enforced by the domain's rules including case-sensitivity, length and 
expiration.  
When using multiple domains, the user's domain must trust the workstations domain.  
There is a 1-to-1 relationship between a Suite user and a domain user. Multiple suite users may not use 
the same domain user name.  
The MASTER and QP9000ADMIN users may not be configured to use Windows Authentication  
Desktop Web Access V6.06 is also compatible with Windows Authentication. See the release notes for 
Desktop Web Access for details. 
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Single Sign-On - Suite 2000 can now be configured to perform single sign-on with Microsoft Windows 
Networks when starting up Desktop or any module. Single Sign-On is enabled by a user with master privileges 
from the System Preferences page. 

 
Notes: 

For a user to take advantage of Single Sign-On their Suite user must be configured to use Windows 
Authentication.  
A user may be configured to opt-out of using single sign on.  
Desktop Web Access V6.06 is also compatible with Single Sign-On. See the release notes for Desktop 
Web Access for details.  

OHSAS 18001 : 2007 Template Pack 

Waypoint Global is proud to introduce the release of a structure only Template pack for OHSAS 18001:2007 - 
Occupational health and safety management system requirements to assist organizations in reaching and 
maintaining conformance to this International Standard. 
 
Structure only Template Packs provide the structure and format of Level I, II and III documents, without content; as 
well as audit checklists with "placeholder" questions and guidance notes so you can build your own internal audit 
checklists. These templates are fully integrated with Suite 2000 so they can take full advantage of all Desktop pools 
and document control functionality saving time and money both during document creation and through on-going 
maintenance to your documentation.  
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Terminal Server Support Improvements

We've been listening and have made major usability improvements to our Terminal Server setup support. 
Customer feedback pointed to two areas that could use improvements to installing and upgrading Terminal Servers. 
Full details can be found in the updated Terminal Server Installation Guide. 

Installing Modules - We've included a new utility that can be used to pick which modules you wish to install to 
the Terminal Server. 

 
This is a major improvement for administrators over the old method of using Explorer to browser to module 
WSSetup directories.  
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User Configuration - 
TS User Configuration no longer requires users to have administrator privileges on Windows 2008 servers 
to license modules.  
TS User Setup now has a UI for users to use to pick what modules they want to license. 

This is an improvement for administrators that eliminates the need to create setup INIs. The INIs will 
continue to work with this new setup for those administrators that wish to control distributing licenses to 
users.  

Both of these new tools are now available from the startup menu in the "All Programs->POWERWAY Desktop" 
folder. 
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Office Viewer for Word & Excel V1.03 

Waypoint Global introduces an advanced method of supporting Microsoft Office 2007/2010 Word & Excel documents. 
The Office Viewer for Word & Excel uses the interfaces available in Microsoft Word and Excel to create a safe 
method of viewing documents. This means that 100% faithful rendering and document navigation of Word & Excel 
documents is now possible. This viewer uses the automation features present in the Microsoft Office applications that 
allow a third party to automate Office functionality to view documents in a safe and secure environment. 
 
Notes: 

Microsoft Word and/or Excel 2007 or 2010 must be installed. The user will be notified if they are missing when 
they attempt to view a Word or Excel document.  

Desktop Web Access V6.06 is compatible with "Office Viewer for Word & Excel". See the release notes for 
Desktop Web Access for details.  

We have included new Document Types that are pre-configured to use the new viewer. 
Microsoft Word 2007  
Microsoft Excel 2007  
Microsoft Word 2010  
Microsoft Excel 2010  

You can then use these new document types when registering new documents in Document Manager. You can 
also modify the selected Document Type of your existing documents and use one of these new Document 
Types.  

Optionally, existing document types can be reconfigured to use the new viewer. Listed here are instructions for 
reconfiguring existing Document Types to use the new viewer. 

1. Select the document type to be changed in the Desktop, Administration->Document Types, workspace.  

2. Click on the View tab. 

 
3. Click off the "Use Internal Viewer if supported" check box.  

4. Enter the following in the Path setting: 
  

5. Enter the following in the View Options: 

For Word Document Types enter: /word:%f   

For Excel Document Types enter: /excel:%f   

6. Enter the following in the Print Options: 

For Word Document Types enter: /word:%f /p   

For Excel Document Types enter: /excel:%f /p  

%P\POWERWAY\MODULES\WPGOView\WPGOfficeView.EXE
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Suite 2000 V3.50 
Desktop V6.05 

Desktop has been modified for compatibility with Desktop Web Access V6.05  
A fix was made to Sybase databases for the report "Electronic Signature Audit Log by Date".  
A fix has been made for users of Quick Reg when registering documents for the Master List.  
Added support for document types using external viewers or editors to handle file extensions with greater than 3 
characters.  

Quality Planner V3.00b 

Fixed a defect with Print Preview.  
Fixed a defect with the Appearance Approval Report not being checked out on new project creation when selecting 
the "Checked Out for Editing" option in the wizard.  

Document Manager V4.07b 

Added support for document types using external viewers or editors to handle file extensions with greater than 3 
characters.  

SQL Server 2000 : End of Life Announcement 

Waypoint Global announces the end of support for MS SQL Server 2000 in future Powerway Suite releases starting 
with V3.50. 
 
We are continuing support for MS SQL Server 2005 and MS SQL Server 2008. As we add new functionality to the 
Powerway Suite solution, we have found it necessary to discontinue development compatible with MS SQL Server 
2000. Older versions of the Powerway Suite will continue to work with MS SQL Server 2000. 
 
As you plan your upgrade to the latest version of Powerway Suite, we want you to be aware that we no longer test 
with MS SQL Server 2000 and strongly recommend you upgrade your database server. Because the environment 
details vary for every company, we offer personalized services to help in this transition process. Our experiences with 
hundreds of customers allow us to share our expertise with you. Our customers have found this saves them many 
hours of frustration when missing something that could affect their system in the future. 
 
If you have any questions about this announcement, please don't hesitate to contact Waypoint's Technical Support 
Department at support@waypointglobal.com. Our goal is to help make this transition as smooth as possible. 
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Suite 2000 V3.40 
Quality Planner V3.00 

Quality Planner has been updated with many new features and improvements. 

All Quality Planner document structures and formats are now harmonized with the suggested formats from the current 
versions of the AIAG reference manuals including, Production Part Approval Process - PPAP - Fourth Edition, 
Potential Failure Mode and Effect Analysis - FMEA - Fourth Edition and Advanced Product Quality Planning and 
Control Plan - APQP - Second Edition. 
 
The DFMEA and PFMEA RPN threshold reports have been modified to take Recommended Action results into the 
threshold calculation. 
 
Added new DFMEA and PFMEA Severity threshold reports where Severity is the second line in the RPN column. 
 
Added new DFMEA and PFMEA Severity times Occurrence threshold reports where SxO is the second line in the 
RPN column. 
 
Certain date entries can now be designated N/A. 

DFMEA: responsibility and target date, Key date  
PFMEA: responsibility and target date, Key date  
PSW: Eng. Changed Date  
PSW: Checking Aid Date  
PSW: Substances of Concern: Other: Confirmation Date  
PSW: Substances of Concern: IMDS: Date transmitted to the customer  
PQP: Summary and Sign-Off: Approval Date  

 
New Project Wizard changes 

Added an option to keep all document drafts.  
Changed default setting for PFMEA style to shared processes.  
Changed to require at least one Finished Part Number when using the Less Finish/Child Part option.  

 
Supporting Documents 

Added the ability to use an existing registered document as a new supporting document. 
This allows a document to be used for multiple projects.  
Added an option to keep all drafts when registering a new supporting document.  
Added an option to not automatically release when registering a new supporting document.  
Added an "Open" with Document Manager button.  
Renamed the Replace button to "Check-in and Approve". Functionality remains the same.  

 
Appearance Approval 

Added Manufacturing Location field.  
Removed "Daimler" from the Chrysler template (only for new projects). Existing documents will remain 
unchanged.  

 
Updated the Team Feasibility Commitment document to more closely match the suggested format from the AIAG 
APQP Reference Manual, Second Edition. Added revision level for the document and made it visible on the printed 
document, adjusted Feasibility Considerations text and amended text for questions 4 and 13. Added more signature 
lines for additional core team members. 
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The eight APQP Checklists have been added as usable word forms for use as supporting documents within projects: 
A-1 Design FMEA Checklist Template  
A-2 Design FMEA Checklist Template  
A-3 New Equipment Checklist Template  
A-4 Product Process Quality Checklist Template  
A-5 Floor Plan Checklist Template  
A-6 Process Flow Chart Checklist Template  
A-7 Process FMEA Checklist Template  
A-8 Control Plan Checklist Template  

 
Documents will now be indexed by 03.Part Number and 03.Customer, where appropriate, to facilitate document filters 
and binder usage. 
 
Gage R&R Studies : Added the Gage index if they are linked to facilitate document filters and binder usage. 
 
Advanced Properties menu choice is available to all documents for easy document property viewing. 
 
Numerous data entry tabs resize automatically to fit the window size so the data is easier to read. 
 
The default FMEA criteria charts can now be changed, per project, to support user created chart tables. The 
QP9000ADMIN user has access to a new menu option under Tools for registering new criteria charts. All dialogs that 
feature a Criteria button will now have an additional button which allows the selection of a new default chart. Users 
can select from the original charts as well as any newly registered user created charts. 
 
The project Information data for Supplier Country is now correctly displayed when edited in the project information 
dialog.  

Desktop V6.04 

Added a new utility that will generate an installation detail report and send it to Waypoint Global support.  
Added a utility to be used to upgrade reports when upgrading from using MSSQL Server 2000 Client.  
Upgrades will no longer reset any customized document types.  

SPC Administrator V4.07b 

SPC Administrator has been modified to improve performance and stability. 
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Suite 2000 V3.30 
Electronic Signature 

This version of Suite 2000 now adds an additional layer of document control security by offering a configurable user 
login confirmation for document dispositions for all Suite 2000 modules. This added confirmation step, when coupled 
with your network security options, will allow your organization to comply with the electronic signature requirements 
stipulated in 21CFR Part 11. Waypoint Global is pleased to offer this additional level of security even to those 
organizations that do not need to comply with the aforementioned requirements but wish to exert even more control 
over their documents.  
For security purposes, all electronic signature steps are recorded in a new audit log. Three consecutive failed 
password signature attempts will cancel the signature step, abort the disposition and create a "failure attemp" audit 
log entry.  
This confirmation feature is a system-wide option that is set to "Required" or "Not Required". It can be set by master 
users in the Suite 2000 Desktop under the System Information/System Preferences area of the left-hand navigational 
tree. The default setting is "Not Required". 

  
Two new reports have been added to the Reports binder for electronic signature. 

Electronic Signature Audit Log by Date  
Deleted Documents by Title  

Procedure Writer V6.08b 

Standard Conversions - A new menu item, named "Change Standard..." has been added to the "Tools" menu. This 
new menu item is only available when your procedure is checked out for editing. If your procedure can be converted 
to a newer version of a standard, this menu item will display a dialog with the possible newer standards. The new 
standard's template pack must be installed to support this feature. This will rename any "Changed" element named in 
the Policy References section of your procedure to match the new standard. This will also index the procedure to the 
new standard. Other work may still be required to update your procedure to the newer standard. Review the new 
standard for additional changes that may be required.  

Instruction Writer V6.08b 

Standard Conversions - A new menu item, named "Change Standard..." has been added to the "Tools" menu. This 
new menu item is only available when your instruction is checked out for editing. If your instruction can be converted 
to a newer version of a standard, this menu item will display a dialog with the possible newer standards. The new 
standard's template pack must be installed to support this feature. This will rename any "Changed" element named in 
the Standard References section of your instruction policy to match the new standard. This will also index the 
instruction to the new standard. Other work may still be required to update your instruction to the newer standard. 
Review the new standard for additional changes that may be required.  

Operating System Support 

Windows Server 2008 R2 has been added to the list of supported server operating systems.  
When using Windows Server 2008 Terminal Services, a user's POWERWAY directory is now located at %
APPDATA%\POWERWAY. This is different from where Windows Server 2003 puts the POWERWAY directory, %
HOMEDRIVE%%HOMEPATH%\Application Data\POWERWAY. When using roaming profiles in a server farm, these 
locations follow the user in their roaming path. It is NOT recommended that you mix Windows 2008 and Windows 
2003 in the same Terminal Server farm.  
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Suite 2000 V3.20 
Desktop and All Modules 

Support for installing Desktop and modules, in this release, on Windows 64-bit clients and Windows 64-bit Terminal 
Servers.  

AS9100C : 2009 Template Pack 

Has been added to reflect and address the latest requirements from the recently released revision of AS9100C.  
The AS9100C Template Pack is a structure only template pack providing the structure and format of level I, II and III 
documents to leverage the capabilities of the Suite 2000 Authoring Tools and audit checklists with starter questions 
from which to build your internal audit checklists in Suite 2000 Audit Manager.  
Customers that are currently on maintenance for the AS9100B : 2004 template pack will receive this Template Pack 
as part of their maintenance agreement, although a new license will be issued with this Template Pack. To receive 
your new license contact Waypoint Global Technical Support (support@waypointglobal.com)  
For considerations on how to convert existing documentation, written to the AS9100B : 2004 version, please contact 
Waypoint Global Technical Support (support@waypointglobal.com) for instructions and assistance.  

ISO/TS 16949 : 2009 Template Pack 

Has been added to reflect and address the latest requirements from the recently released revision of ISO/TS 16949.  
The ISO/TS 16949 Template Pack is a content-rich template pack containing many example documents complete 
with industry-specific content to help you jumpstart your implementation or ease your transition. An example policy 
manual, 38 procedures and 2 instructions are included as well as 5 separate audit checklists, one for each clause of 
the standard, that contain hundreds of relevant audit questions and guidance notes to assist your auditor teams in 
building a high-impact internal audit program.  
Customers that are currently on maintenance for the ISO/TS 16949 : 2002 template pack will receive this Template 
Pack as part of their maintenance agreement, although a new license will be issued with this Template Pack. To 
receive your new license contact Waypoint Global Technical Support (support@waypointglobal.com)  
For considerations on how to convert existing documentation, written to the ISO/TS 16949 : 2002 version, please 
contact Waypoint Global Technical Support (support@waypointglobal.com) for instructions and assistance.  

Desktop V6.02 

Document Properties: "Checked-Out Path" now displays the full path in a Revision's Change Control tab. It previously 
clipped long paths to the display width.  
Generating new Non-conformances supports customized form numbers.  

Document Manager V4.06 

The "Checked-Out Path" now displays the full path in a Revision's Change Control tab. It previously clipped long 
paths to the display width.  

Policy Writer V6.07 

Support for Copy & Paste from Word 2007.  
Support for Policy Manual Standard conversions. A new menu item, named "Change Standard..." has been added to 
the "Tools" menu. This new menu item is only available when your policy is checked out for editing. If your policy can 
be converted to a newer version of a standard, this menu item will display a dialog with the possible newer standards 
to pick from. The new standard's template pack must be installed to support this feature. This will rename any 
"Changed" element named in the Requirements section of your policy to match the new standard. This will also index 
the policy to the new standard.  

Procedure Writer V6.08 

Support for Copy & Paste from Word 2007.  

Instruction Writer V6.08 

Support for Copy & Paste from Word 2007. 
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Corrective Action V2.06 

Generating new Non-conformances supports customized form numbers.  

List Builder V3.01 

The V3.01c patch has been merged into the main List Builder install.  

Quality Planner V2.63 

The V2.62b patch has been merged into the main Quality Planner install.  

NOTES : 

The following modules have not had their version numbers changed with this release. 

Audit Manager  
Cimmetry Engineering Viewer  
Number Dispenser  
SPC Administrator  
SPC Examiner  
SPC Operator  

In a Group installation, if you want 64-bit client support you must choose to refresh these modules. During the upgrade, at 
the installation check list, click ON the check boxes to refresh these modules. Older modules are not supported for use on 
64-bit clients. 
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Suite 2000 V3.01 
Desktop Web Access Support 

Support for managing licenses for Desktop Web Access has been added to Desktop. 

SQL Server Client support 

Suite 2000 V3.01 has improved the support for SQL server Clients. Administrators now have the option of using one of 
these driver combinations: 

SQL Server Native Driver (Requires SQL Server 2000 client and works with all versions of SQL Server)  
SQL Server ODBC (SQL Server Authentication)  
SQL Server ODBC (Trusted Authentication)  
SQL Server ODBC Native (SQL Server Authentication)  
SQL Server ODBC Native (Trusted Authentication)  

SQL Server Native Driver uses SQL Server Authentication ONLY, Trusted Connections are not supported. There are two 
versions of the SQL Server ODBC Native driver available from Microsoft, one from SQL Server 2005 and one from SQL 
Server 2008. They both can be installed on a system at the same time. If both are present Workstation setup will pick the 
latest version. 

If you wish to change which SQL Server driver is used for an existing install, contact Waypoint Global Technical Support 
(support@waypointglobal.com) for instructions and assistance. 

Windows Vista / Windows 7 - Migration Considerations 

Suite 2000 V3.01 does not directly support either the "In place installation (upgrade in place)" or "Clean Installation" 
upgrade options for Vista or Windows 7 from prior Windows versions. If you are considering a Windows migration, before 
beginning the migration, contact Waypoint Global Technical Support (support@waypointglobal.com) for instructions and 
assistance. 

Windows Administrator Privileges 

Suite 2000 no longer requires users to be Windows administrators to use the software. New installs will automatically get 
this new benefit. This means that the Suite 2000 "Data" directories have been moved to the "Application Data" folder 
designated by Microsoft. 
 
For Windows XP and Windows Server 2003 the new "Data" folder is at "%ALLUSERSPROFILE%\Application 
Data\POWERWAY". This is normally located at "C:\Documents and Settings\All Users\Application Data\POWERWAY". 
 
For Windows Vista, Windows Server 2008 and Windows 7 the new "Data" folder is at "%ALLUSERSPROFILE%
\POWERWAY". This is normally located at "C:\ProgramData\POWERWAY". 
 
In the Group Edition is a utility provided in the WSSetup\Remap directory that will do a conversion for existing installations 
to enable this support. If existing Personal Edition installs wish to convert they should contact Waypoint Global Support for 
instructions. 
 
Terminal Services has never required a user be a Windows administrator to do a TSUserSetup or use the software. 
 
In all cases we still require a Windows administrator to install the software.
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Help Files 

Windows Vista, Windows Server 2008 and Windows 7 do not support the help file format used in Suite 2000 V3.01. 
Microsoft has posted on their web site a Knowledge Base article download that will allow Vista, Windows Server 2008 and 
Windows 7 to read our help files. 
I cannot open Help files that require the Windows Help (WinHlp32.exe) program. 

Quality Planner 

Quality Planner has received the following updates: 
 
The Gage R&R Study formulas have been upgraded to match the AIAG MSA 3rd Edition manual. Also, the precision of the 
results have been extended to more decimal places to show more accuracy. 
 
The "Suggested DFMEA/PFMEA Evaluation Criteria" charts have been updated to match the AIAG FMEA 4th Edition 
manual. 

 
 
 
 
 
 
 
Suite 2000 V3.00 
ISO 9001:2008 Template Pack 

The ISO 9001 Template Pack has been updated, including structural and content changes, to reflect the 2008 revision to 
the standard. Customers that are currently on maintenance for the ISO 2001:2000 template pack will receive this Template 
Pack as part of their maintenance agreement, although a new license will be issued with this Template Pack. For 
considerations on how to convert existing documentation, written to the ISO 9001:2000 version, please reference the 
Waypoint Global Web Site. 

Terminal Server Upgrades 

After the server administrator has upgraded the Terminal Server Desktop using TSSetup, each Terminal Server user will 
need to run the TSUserSetup to complete the upgrade. Desktop will not launch for a user until this is done. This is not 
normally needed but is required for any upgrade from before V3.00. This upgrade, using TSUserSetup, can be run un-
attended and requires no command line parameters.
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